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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2004 - 2009 Hewlett-Packard Development Company, L.P.

This product includes Xerces XML Java Parser software, which is Copyright (c) 1999 The Apache Software 
Foundation. All rights reserved. 

This product includes JDOM XML Java Parser software, which is Copyright (C) 2000-2003 Jason Hunter & 
Brett McLaughlin. All rights reserved.

This product includes JClass software, which is (c) Copyright 1997, KL GROUP INC. ALL RIGHTS 
RESERVED.

This product includes J2TablePrinter software, which is © Copyright 2001, Wildcrest Associates (http://
www.wildcrest.com)

This product includes Xalan  XSLT Processor software, which is  Copyright (c) 1999 The Apache Software 
Foundation.  All rights reserved.

This product includes EXPAT XML C Processor software, which is Copyright (c) 1998, 1999, 2000 Thai Open 
Source Software Center Ltd and Clark Cooper Copyright (c) 2001, 2002 Expat maintainers.

This product includes Apache SOAP software, which is Copyright (c) 1999 The Apache Software Foundation.  
All rights reserved.

This product includes O'Reilley Servlet Package software, which is Copyright (C) 2001-2002 by Jason Hunter, 
jhunter_AT_servlets.com.All rights reserved. 

This product includes HTTPClient Package software, which is Copyright (C) 1991, 1999 Free Software 
Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA  02111-1307 USA.

This product includes Perl software, which is Copyright 1989-2002, Larry Wall. All rights reserved.

This product includes Skin Look And Feel software, which is Copyright (c) 2000-2002 L2FProd.com. All rights 
reserved.

This product includes nanoXML software, which is Copyright (C) 2000 Marc De Scheemaecker, All Rights 
Reserved.

This product includes Sixlegs PNG software, which is Copyright (C) 1998, 1999, 2001 Chris Nokleberg

This product includes cURL & libcURL software, which is Copyright (c) 1996 - 2006, Daniel Stenberg, 
<daniel@haxx.se>. All rights reserved.

This product includes Quartz - Enterprise Job Scheduler software, which is Copyright 2004-2005 
OpenSymphony
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This product includes Free DCE software, which is (c) Copyright 1994 OPEN SOFTWARE FOUNDATION, 
INC., (c) Copyright 1994 HEWLETT-PACKARD COMPANY, (c) Copyright 1994 DIGITAL EQUIPMENT 
CORPORATION, Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, 
Boston, MA  02111-1307  USA

This product includes DCE Threads software, which is Copyright (C) 1995, 1996 Michael T. Peterson

This product includes Jboss software, which is Copyright 2006 Red Hat, Inc.  All rights reserved.

Trademark Notices

Java™ is a U.S. trademark of Sun Microsystems, Inc.

UNIX® is a registered trademark of The Open Group.

Oracle® is a registered trademark of Oracle Corporation and/or its affiliates.

Windows® is U.S. registered trademarks of Microsoft Corporation. 
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.

The following table indicates changes made to this document since the last released edition.  

Chapter Changes

Chapter 1 Version number changes, added information about what’s new in this version

Chapter 2 Added new upgrade chapter

Chapter 3 Version number changes

Chapter 4 New procedures to configure distributed system using LIR (location independent 
reporting) and copy policies
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Support

You can visit the HP software support web site at:

http://support.openview.hp.com/support.jsp 

HP Software online support provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels and HP Passport, go to:

http://support.openview.hp.com/new_access_levels.jsp 
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1 Overview
This chapter covers the following topics:

• Device performance (resources and traffic volume) in a “single view”

• Folders and reports

• Statistics; applying constraints to a report; adding locations

• Sources for additional information

Device Performance in a “Single View”

HP Performance Insight is a performance management and reporting application. Long-term 
data collection, in-depth analysis, performance baselining, and automated web-based 
reporting are this application’s primary strengths. 

The reports in the Executive Summaries Report Pack display the following statistics for 
devices:

• CPU utilization

• Buffer utilization

• Memory utilization

• Traffic volume on device interfaces

Previously, before these reports were created, you had to consult reports in two places to get 
this information, the Interface Reporting Report Pack and the Device Resource Report Pack. 
Executive Summaries puts this information in one place, hence the term single view.

The following table outlines enhancements to the Executive Summaries Report Pack.

Version Date of Release Features/Enhancements

1.0 April 2004 5 reports; no datapipe [not applicable]
Supports Oracle only; does not support Sybase
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Folders and Reports

Executive Summaries 1.11 contains device-oriented reports and location-oriented reports. The 
device-oriented reports roll-up (aggregate) traffic volume from the interface level to the device 
level. The location-oriented summary reports roll-up resource utilization and traffic volume 
for all the devices owned by one customer at one location. If you are logging into the OVPI 
Application Server, you will see two folders: 

• Device

• Location 

The Device folder contains two reports:

• Device Single View Summary

• Device Single View Top Ten

The Location folder contains three reports:

• Executive Summary 

• Executive Summary Aggregate Availability & Traffic

• Executive Summary Top Ten

See Chapter 5, Sample Reports for a description of each report. 

Types of Statistics

Executive Summaries tracks the following statistics:

CPU Statistics

• Average utilization

• Maximum utilization

• Busy hour 

1.1 April 2007 Location independent reporting
UPGRADE_ES_to_11
defectfixes:
• QXCR1000351403
• QXCR1000351536

1.1 October 2007 Prerequisites:
• PI 5.3
• Common Property Tables 3.7

1.11 September 2009 Prerequisites:
• PI 5.41
• Common Property Tables 3.91

Version Date of Release Features/Enhancements
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• Baseline busy hour

• F30/F60/F90 busy hour 

• CPU percentage of exceptions

Memory Statistics

• Average utilization

• Maximum utilization

• Busy hour 

• Baseline busy hour

• F30/F60/F90 busy hour

• Memory percentage of exceptions 

Buffer Statistics

• Average utilization

• Maximum utilization

• Busy hour utilization

• Baseline busy hour

• F30/F60/F90 busy hour

• Buffer percentage of exceptions

Traffic Statistics

• Traffic volume per device

• Interface availability

• Frames (total for the day, across all devices)

• Errors (total for the day, across all devices)

• Discards (total for the day, across all devices)

Applying Constraints to a Report

Editing a parameter, or applying a constraint, eliminates data you are not interested in 
seeing. For example, if you edit the Customer Name parameter, only data for the customer you 
typed in the Customer Name field will appear in the report. Executive Summaries 1.11 
supports the following constraints:

• Customer Name

• Customer ID

• Location Name

• Location ID

• Device Name

“percentage of exceptions” is calculated by dividing the number of exceptions by 96 (4 x 24 
samples = 96 total samples) and multiplying the result by 100.
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• Make

• Model

If you are using Report Viewer, follow these steps to apply a constraint:

1 Select Edit > Parameter Values from the menu bar.

2 When the Modify Parameter Values window appears, click the Current Value field.

3 Enter a new value.

4 Click OK.

If you are using the Web Access Server, follow these steps:

1 Click  (the Edit icon) at the bottom right-hand corner of the report.

2 When the Edit Parameters window opens, type the constraint in the appropriate field.

3 Click Submit.

Adding Locations to Reports

If you are already using Interface Reporting and Device Resource, and if you used Common 
Property Tables to import locations into those reports, you will not have to add your locations 
in order to see your locations in Executive Summaries. The reports in Executive Summaries 
1.11 will inherit locations from Common Property Tables.

Sources for Additional Information

For information regarding the latest enhancements to this package and any known issues, 
refer to the Executive Summaries Report Pack Release Notes. You may also be interested in 
these documents: 

• Device Resource Report Pack User Guide

• Common Property Tables User Guide

• Interface Reporting Report Pack User Guide

• RMON Ethernet Statistics Report Pack User Guide

• PI Report Packs, CD-ROM Release Notes, September 2009

Manuals for the core product, OVPI, and manuals for the reporting solutions and shared 
packages that run on OVPI can be downloaded from this site:

http://ovweb.external.hp.com/lpe/doc_serv/

The user guides for OVPI are listed under Performance Insight. The user guides for report 
packs and datapipes are listed under Performance Insight Report Packs. 

The manuals listed under Performance Insight Report Packs indicate the month and year of 
publication. If a manual is revised and reposted, the date will change. Since we post revised 
manuals on a regular basis, we recommend searching this site for updates before using the 
PDF that was copied to the Docs directory on the report pack CD-ROM.
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2 The Upgrade Install
This chapter covers the following topics: 

• Guidelines for a smooth upgrade

• Upgrading to Executive Summaries 1.11

• Uninstalling Executive Summaries 

Guidelines for a Smooth Upgrade

The report pack CD contains report packs, datapipes, and several shared packages. If you 
insert the report pack CD in the CD-ROM drive and launch the package extraction program, 
the install script will extract every package on the CD to the Packages directory on your 
system. When the extract finishes, the install script prompts you to launch PI and start 
Package Manager. 

If the package extraction step has already taken place, all of the packages associated with 
Executive Summaries, including the latest upgrade package, are in the Packages directory on 
your system awaiting installation. To upgrade Executive Summaries, start Package Manager 
and follow the on-screen instructions. Before beginning the upgrade, be familiar with the 
following topics:

• Prerequisites for Executive Summaries

• Upgrading Executive Summaries in a distributed environment

Prerequisites for Executive Summaries

Make sure the following software is already installed/upgraded before upgrading Executive 
Summaries:

• Performance Insight 5.41

• All available service packs for PI 5.41

• Common Property Tables 3.91

• Device Resource Report Pack 3.42 

— At least one vendor-specific datapipe

• Interface Reporting Report Pack 5.52

— Interface Discovery Datapipe 2.5

— Interface Reporting ifEntry Datapipe 2.52
  13



Distributed Systems

If you are running PI as a distributed system, every server must be running PI 5.41 and all 
the Service Packs available for PI 5.41. Here is an overview of the installation procedure for 
adistributed environment:

1 Verify that every server is running PI 5.41 and all available service packs. 

2 Disable trendcopy on the central server. 

3 If necessary, upgrade the following packages:

• Interface Reporting (upgrade to version 5.52)

• Device Resource (upgrade to version 3.42)

4 Install Executive Summaries on the central server and on every satellite server.

5 Re-enable trendcopy on the central server.

6 Reconfigure your central and satellite servers.

When you set up your distributed system the first time, you configured trendcopy pull 
commands from the central server and switched off hourly aggregations at each satellite 
server. These changes must be re-done by following the steps in Chapter 4, Setting Up a 
Distributed System.

Upgrading Executive Summaries

Perform the following tasks to upgrade to Executive Summaries 1.11:

• Task 1: Stop OVPI Timer and extract packages from the report pack CD

• Task 2: If necessary, upgrade Common Property Tables

• Task 3: If necessary, upgrade Interface Reporting and Device Resource Report Packs

• Task 4: Install ES_Upgrade_to_111.

• Task 5: Restart OVPI Timer

Task 1: Stop OVPI Timer and extract packages from the report pack CD

1 Log on to the system. On UNIX systems, log on as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD. On Windows, a Main Menu displays automatically; on UNIX, 
mount the CD if the CD does not mount automatically, navigate to the top level directory 
on the CD, and run the ./setup command. 

4 Type 1 in the choice field and press Enter. The install script displays a percentage complete 
bar. When the copy is complete, the install script starts Package Manager. The Package 
Manager welcome window opens.
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Once the extract is finished, you have the option of navigating to the Packages directory on 
your system and seeing the following folders under the ExecutiveSummary folder:

• Docs

• ExecutiveSummary.ap

• ES_Upgrade_to_111.ap

Task 2: Upgrade Common Property Tables 

If you have not upgraded to Common Property Tables 3.91, do this now. Observe these rules:

• Do not install other packages at the same time; install the upgrade package for Common 
Property Tables and only the upgrade package for Common Property Tables.

• When the Report Deployment window opens, accept the default to Deploy Reports. If you 
don’t deploy reports, you won’t have access to the forms that come with Common Property 
Tables. 

• When the install completes, click Done to return to the Management Console.

If you need help with the upgrade, refer to the Common Property Tables User Guide. 

Task 3: Upgrade Device Resource and Interface Reporting

Refer to the following manuals for more information about upgrading these packages:

• Device Resource Report Pack User Guide

• Interface Reporting Report Pack User Guide 

Task 4: Install ES_Upgrade_to_111

1 Start Package Manager. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. 

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
accept the defaults for application server name and port; type your user name and 
password for the application server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following package:

ES_Upgrade_to_111 

7 Click Next. The Type Discovery window opens. Disable the default and click Next. The 
Selection Summary window opens.

8 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, the package installation complete message appears.

9 Click Done. 

Task 5: Restart OVPI Timer

Windows: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
The Upgrade Install 15



Uninstalling Executive Summaries 

Follow these steps to uninstall the Executive Summaries Report Pack:

1 Log on to the system. On UNIX systems, log on as root.

2 Stop OVPI Timer and wait for processes to stop running.

Windows: Do the following:

a From the Control Panel, select Administrative Tools  Services

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

UNIX: As root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop

3 Start Package Manager. 

a Launch Performance Insight and select Management Console.

b Select Tools  Package Manager

The Welcome window opens.

4 Click Next. The Packages Location window opens.

5 Click Uninstall.

6 Click Next. The Report Undeployment window opens. Accept the default for Undeploy 
Reports; accept the defaults for application server name and port; enter your user name 
and password for the OVPI Application Server. 

7 Click Next. The Package Selection window opens.

8 Click the check box next to the following packages:

• Executive Summaries

• Executive Summaries Demo (if installed)

9 Click Next. The Selection Summary window opens.

10 Click Uninstall. The Progress window opens. When the uninstall process is complete, a 
removal complete message appears.

11 Click Done to return to the Management Console.

12 Restart OVPI Timer.

Windows: Do the following:

a From the Control Panel, select Administrative Tools  Services

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

UNIX: As root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer start

— Sun: sh /etc/init.d/ovpi_timer start
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3 The New Install
This chapter covers the following topics: 

• Guidelines for a smooth install

• Installing Executive Summaries 

• Package removal

Guidelines for a Smooth Install

Our reporting solution have two ingredients, a report pack and a datapipe. Some reporting 
solutions have multiple datapipes. When you install a datapipe, you configure OVPI to collect 
a specific type of performance data at a specific interval. When you install a report pack, you 
configure PI to summarize and aggregate the data collected by the datapipe.

When you insert the report pack CD in the CD-ROM drive and launch the package extraction 
program, the install script extracts packages from the CD and copies the results to the 
Packages directory on your system. After the extraction process finishes, the install script 
prompts you to launch Performance Insight and start Package Manager. 

If the packages on the report pack CD are already in the Packages directory awaiting 
installation, Executive Summaries is ready to install. If packages have not been extracted 
from the CD yet and you need assistance with that step, use the extract procedure later in 
this chapter. Before installing packages, review the following guidelines.

Prerequisites for Executive Summaries

Following is a list of prerequisites for Executive Summaries:

• Performance Insight 5.41

• All available service packs for PI 5.41

• Common Property Tables 3.91 or higher

• Device Resource Report Pack 3.42 

— one or more vendor-specific datapipes

• Interface Reporting Report Pack 5.52

— Interface Discovery Datapipe 2.5

— Interface Reporting ifEntry Datapipe 2.52

There are no datapipes for Executive Summaries. Executive Summaries uses data collected 
by Interface Reporting and Device Resource.
  17



Common Property Tables

If you are running earlier version of Common Property Tables, upgrade to version 3.91. If you 
are not running any version of Common Property Tables, let Package Manager install the 
latest version of Common Property Tables for you. Do not install the upgrade for Common 
Property Tables and other packages at the same time. Install the upgrade for Common 
Property Tables and only the upgrade for Common Property Tables. For more information 
about installing and using Common Property Tables, refer to the Common Property Tables 
User Guide.

Interface Reporting and Device Resource

If you are running earlier versions of Interface Reporting or Device Resource, upgrade those 
packages before installing Executive Summaries. If you need help upgrading those packages, 
refer to the following manuals:

• Device Resource Report Pack User Guide

• Interface Reporting Report Pack User Guide 

Distributed Systems

If you are installing Executive Summaries in a distributed environment, package installation 
is more complicated. Here is an outline of the procedure:

1 Verify that every server is running PI 5.41 and all available service packs. 

2 Disable trendcopy on the central server. 

3 Install Executive Summaries on the central server and on every satellite server.

4 Re-enable trendcopy on the central server.

5 Configure your central and satellite servers.

For details about the configuration steps, see Chapter 4, Setting Up a Distributed System.

Installing Executive Summaries 

To install Executive Summaries, perform these tasks:

• Stop OVPI Timer and extract packages from the report pack CD

• If necessary, upgrade Common Property Tables 

• If necessary, upgrade Device Resource and Interface Reporting

• Install Executive Summaries 

• Restart OVPI Timer

Task 1: Stop OVPI Timer and extract packages from the report pack CD

1 Log on to the system. On UNIX® systems, log on as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Do the following:
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a From the Control Panel, select Administrative Tools  Services

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

UNIX: As root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. 

Windows: The Main Menu opens automatically. 

UNIX: 

a Mount the CD (if the CD does not mount automatically)

b Navigate to the top level directory on the CD

c Run ./setup 

4 Type 1 in the choice field and press Enter. The install script displays a percentage 
complete bar. When the copy is complete, the install script starts Package Manager. The 
Package Manager welcome window opens.

Task 2: Upgrade Device Resource and Interface Reporting

Refer to the following manuals for more information about upgrading these packages:

• Device Resource Report Pack User Guide

• Interface Reporting Report Pack User Guide 

Task 3: Install Executive Summaries 

1 Start Package Manager. The Package Manager welcome window opens. 

2 Click Next. The Package Location window opens.

3 Click Install.

4 Approve the default installation directory or select a different directory if necessary. Use 
the browse feature to select a different directory.

5 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
enter your user name and password for the OVPI Application Server. 

6 Click Next. The Package Selection window opens. 

7 Click the check box next to the following packages:

• Executive_Summary

• Executive_Summary_Demo (optional)

8 Click Next. The Type Discover window opens. 

Installing the Demo Package is optional. The Demo Package can be installed 
alone, or you can install it along with everything else.

If you are installing Common Property Tables, Device Resource, and Interface 
Reporting for the first time, click the check boxes next to these packages.
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9 To run Discover immediately after package installation, accept the default and click Next. 
The Selection Summary window opens. 

10 Click Install. The Installation Progress window opens. When installation is complete, a 
package installation complete message appears.

11 Click Done to return to the Management Console. 

Task 4: Restart OVPI Timer

Windows: Do the following:

1 From the Control Panel, select Administrative Tools  Services.

2 Select OVPI Timer from the list of services.

3 From the Action menu, select Start.

UNIX: As root, do one of the following:

• HP-UX: sh /sbin/init.d/ovpi_timer start

• Sun: sh /etc/init.d/ovpi_timer start

Uninstalling Executive Summaries 

Follow these steps to uninstall the Executive Summaries Report Pack:

1 Log on to the system. On UNIX systems, log on as root.

2 Stop OVPI Timer and wait for processes to stop running.

Windows: Do the following:

a From the Control Panel, select Administrative Tools  Services

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

UNIX: As root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop

3 Start Package Manager. 

a Launch Performance Insight and select Management Console.

b Select Tools  Package Manager

The Welcome window opens.

4 Click Next. The Packages Location window opens.

5 Click Uninstall.

6 Click Next. The Report Undeployment window opens. Accept the default for Undeploy 
Reports; accept the defaults for application server name and port; enter your user name 
and password for the OVPI Application Server. 

7 Click Next. The Package Selection window opens.

8 Click the check box next to the following packages:
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• Executive Summaries

• Executive Summaries Demo (if installed)

9 Click Next. The Selection Summary window opens.

10 Click Uninstall. The Progress window opens. When the uninstall process is complete, a 
removal complete message appears.

11 Click Done to return to the Management Console.

12 Restart OVPI Timer.

Windows: Do the following:

a From the Control Panel, select Administrative Tools  Services

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

UNIX: As root, do one of the following:

— HP-UX: sh /sbin/init.d/ovpi_timer start

— Sun: sh /etc/init.d/ovpi_timer start
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4 Setting Up a Distributed System
These are the steps to follow when setting up a distributed system:

• Decide whether or not you want local reporting

• Install the right set of packages on each server (a central server that is not polling will not 
need datapipes; the satellite servers will need datapipes)

• Verify that the system clocks in your environment are synchronized

• Register your satellite servers

• If you are not copying rate data to the central server, enable LIR on the central server

• If you enable LIR, add LIR mapping with the time type set to rate

• Verify that you have all the copy policies you need

• Configure the central server (manual edits to trendtimer.sched and .pro files)

• Configure each satellite server (manual edits to trendtimer.sched and .pro files)

If you want to set up a distributed system, you can implement local reporting or you can 
implement centralized reporting. If you want local reporting, you need to deploy reports when 
you install the report pack on each satellite server, and you need to allow summarizations to 
run on each satellite server. If you do not want local reporting, then you do not need to deploy 
reports when you install a report pack on a satellite server and you can disable the scripts 
that run summarizations on each satellite server.

Before Location Independent Reporting (LIR) was available, our recommendation to anyone 
setting up a distributed system was to deploy reports on satellite servers, keep rate data on 
satellite servers, copy hourly data to the central server, and disable summarizations above the 
hourly level on satellite servers. The advantage to this approach was that it kept a large 
volume of rate data off the network and it decreased the processing load on the central server. 
The disadvantage is that the central server could not display a Near Real Time (NRT) report. 
The only NRT report was a local NRT report, on a satellite server. LIR overcomes this 
disadvantage. If you enable LIR, you can open an NRT report on the central server and 
drill-down on table selections. The selections you make cause the central server to query a 
satellite server for locally aggregated data. Of course, if you would rather copy rate data to the 
central server, you can. If you do that, then enabling LIR is not necessary.

Check for Proper Package Installation

You want the following packages installed on the central server:

• Executive Summary 1.11

• Interface Reporting 5.52

• Interface_Reporting_Device 5.31
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• Interface_Reporting_Location 5.31

• Interface_Reporting_Protocol 5.31

• Interface_Reporting_Vlan (optional)

• Device Resource 3.42

• Device Resource Backplane 3.20 (optional)

• If you want to enable thresholding for aggregated data only, install the thresholds 
sub-package(s) and the Thresholds Module on the central server.

You want the following packages installed on each satellite server:

• Executive Summary 1.11

• Interface Reporting 5.52

• Interface_Reporting_Device 5.31

• Interface_Reporting_Location 5.31

• Interface_Reporting_Protocol 5.31

• Interface_Reporting_Vlan (optional)

• Interface Discovery Datapipe 2.5

• Interface Reporting ifEntry Datapipe 2.51

• Cisco VLAN Datapipe 2.1 (optional)

• OPNET Export Datapipe 2.0 (optional)

• Device Resource 3.42

• Device Resource Backplane 3.20 (optional)

Install at least one Device Resource vendor-specific datapipe on each satellite server. If the 
Device Resource Backplane sub-package is installed, install one of the following datapipes:

• Alcatel Xylan Switch Datapipe

• Cisco Switch Datapipe

If you want to enable thresholding for hourly data or rate data, install the thresholds 
sub-package(s) and the Thresholds Module on satellite servers. 

Split Polling and Avoid Duplicate Polling

You must decide how polling will take place, and then split the device groups accordingly. 
These are your options:

• Split polling between the central server, satellite servers, and remote pollers

• Split polling between satellite servers and remote pollers

• Split polling between multiple remote pollers

The situation you must avoid is duplicate polling, which arises when the device groups 
assigned to one server happen to be the same device groups assigned to a different server, or 
to a remote poller. To avoid this problem, make sure that you split the polling function 
properly. The polling function is split properly when:

• No two servers have the same polling policies and device group lists
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• No two remote pollers have the same polling policies and device group lists

• Servers and remote pollers do not share polling policies and device group lists

For more information about polling policies and how to create them, refer to the Interface 
Reporting ifEntry Datapipe 2.52 User Guide.

Configuring the Central Server

To configure the central server, perform the following tasks:

• Task 1: Register the satellite server by setting the database role

• Task 2: Enable LIR

• Task 3: Add LIR mappings

• Task 4: Verify the automatically generated copy policies

• Task 5: Modify the trendtimer.sched file

• Task 6: Modify the DeviceResourceReporting_Hourly.pro file

Task 1: Register the satellite server by setting the database role

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the database system.

4 Click Database Properties.

5 From the Database Role list, select the Satellite Server role.

6 Enter any information necessary to configure the Satellite Server role.

Task 2: Enable LIR

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Select the LIR enabled check box.

Task 3: Add LIR mappings

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Click Add Mapping.

6 From the Select Satellite Server list, select a satellite server to which to add a mapping.

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application.
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7 Select the Category data table option.

8 Select Interface Reporting from the drop down list.

9 Select the rate data type.

10 Click Add to List.

11 Click Add to list and repeat step 6 through step 10 but select DeviceResources from the 
drop down list in step 8.

12 Click OK.

13 Click Apply.

A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type selected when adding an LIR mapping (in step 10 above) determines 
the type of data copied (defined in the generated copy policy). The type of data copied is one 
summarization level greater than the data type selected in the LIR mapping. For example, if 
you select an hourly data type, you will generate a daily data copy policy.

Task 4: Verify the automatically generated copy policies

Verify that a copy policy has been generated for the following tables and that the copy type is 
set correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.

3 Find the following tables and verify the copy type is set to Property and Data for each 
table:

• SHDevRes_Device

• SHDevRes_DeviceMem

• SHDevRes_Card

• SHIRDevPorts

If a copy policy has not been generated for a table, do the following:

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy 
Manager. The Copy Policy Wizard displays.

2 Click Next. The Satellite Server and Copy Policy Selection Page displays.

3 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server.

4 Select Single Table and select SHIRDevPorts from the pull down list.

5 Click Next. The Copy Type Selection Page displays.

6 Select Property and Data.

7 Click Next. The Summary page displays.

8 Verify the information in the summary window. If the information is not correct, you can 
modify it by clicking Back.

9 Click Finish.

If the copy type is not set to Property and Data, do the following:

1 Double-click the copy policy.

2 Select the Property and Data copy type.
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3 Click OK.

Task 5: Modify the trendtimer.sched file

The trendtimer.sched file is found in the {DPIPE_HOME}/lib/ directory where 
{DPIPE_HOME} is the directory in which OVPI is installed.

Make the following changes:

• Find and change the following line (modify the daily processing time):

24:00+4:00 - - {DPIPE_HOME}/bin/trend_proc -f 
{DPIPE_HOME}/scripts/IR_DevPort_DMF__Process.pro

to

24:00+3:00+40 - - {DPIPE_HOME}/bin/trend_proc -f 
{DPIPE_HOME}/scripts/IR_DevPort_DMF__Process.pro

• Find and comment out the following line (only if the central server is not a polling server):

1:00+20 - - {DPIPE_HOME}/bin/trend_proc -f 
{DPIPE_HOME}/scripts/IR_DevPor_Hourly_Process.pro

• Find and comment out the following line:

1:00+40 - - {DPIPE_HOME}/bin/trend_proc -f 
{DPIPE_HOME}/scripts/DeviceResourceReporting_Hourly.pro

Task 6: Modify the DeviceResourceReporting_Hourly.pro file

The DeviceResourceReporting_Hourly.pro file is found in the 
{DPIPE_HOME}/scripts/ directory where {DPIPE_HOME} is the directory in which OVPI is 
installed.

Make the following change to this file:

• Comment out the block1 section.

Configuring a Satellite Server

A satellite server can perform local reporting from the satellite database without the Location 
and Protocol modules. However, if you want a satellite server to perform full reporting, make 
sure that these modules are installed. If the Location and Protocol modules are installed, 
begin this procedure at step 10.

Follow these steps to configure a satellite server:

1 Modify the trendtimer.sched file (found in the {DPIPE_HOME}/lib/ directory where 
{DPIPE_HOME} is the directory in which OVPI is installed).

• Find and change the following line (modify the daily processing time):

24:00+4:00 - - {DPIPE_HOME}/bin/trend_proc -f 
{DPIPE_HOME}/scripts/IR_DevPort_DMF_Process.pro

to

24:00+3:40 - - {DPIPE_HOME}/bin/trend_proc -f 
{DPIPE_HOME}/scripts/IR_DevPort_DMF_Process.pro
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• Find and comment out the following line:

24:00+3:00 - - {DPIPE_HOME}/bin/trend_proc -f 
{DPIPE_HOME}/scripts/DeviceResourceReporting_Daily.pro

2 Modify the IR_DevPort_DMF_Process.pro file (found in the {DPIPE_HOME}/
scripts/ directory where {DPIPE_HOME} is the directory in which OVPI is installed).

Comment out the IR_DMF1 block (comment out the begin:IR_DMF1 wait and 
end:IR_DMF1 lines).

3 Modify the IR_DevPort_Hourly_Process.pro file (found in the {DPIPE_HOME}/
scripts/ directory where {DPIPE_HOME} is the directory in which OVPI is installed).

Uncomment the IR_2 block (uncomment the begin:IR_2 wait and end:IR_2 lines).

4 Modify the DeviceResourceReporting_Hourly.pro file:

The DeviceResourceReporting_Hourly.pro file is found in the 
{DPIPE_HOME}/scripts/ directory where {DPIPE_HOME} is the directory in which 
OVPI is installed.

Make the following change to this file:

• Uncomment the block2 section.

5 Using Table Manager, reduce the retention period of the SHIRDevPorts table from 4 days 
to 2 days. 

6 Configure any protocols that should not be monitored to unmonitored.

7 Configure datapipe polling policies; make sure that each network device is polled by one 
satellite server only.

8 If you are using remote pollers, avoid duplicate polling between remote pollers and 
duplicate polling between a satellite and a remote poller.

9 If a satellite server has two or more remote pollers, create separate polling policies for 
each remote poller and use views and types to separate the devices.

10 Configure polling policies for the IR ifEntry Datapipe, taking care that each node is polled 
from one system only. Follow these guidelines:

• If remote pollers are being used, avoid duplicate polling by remote pollers, and 
duplicate polling by the satellite server and remote pollers.

• If a satellite server has two or more remote pollers, create separate polling policies for 
each poller and use view groups to separate the devices.

• Each poller must have 13 polling policies associated with it:

— 1 for the RIRRouterSystem table

— 8 for the Interface Discovery Datapipe

— 4 for the Interface Reporting ifEntry Datapipe

If you need help configuring polling policies, refer to the Interface Reporting ifEntry Datapipe 
User Guide. See Chapter 3, Datapipe Configuration.
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Synchronizing System Clocks

Make sure that the system clock on each satellite server is synchronized with the system clock 
on the central server.
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5 Sample Reports
Executive Summaries 1.11 contains five reports:

1 Device Single View Summary

2 Device Single View Top Ten Summary

3 Executive Summary

4 Executive Summary Aggregate Availability and Traffic

5 Executive Summary Top Ten

Report 1: Device Single View Summary [see sample below]

This report creates a single view of device performance by combining traffic volume statistics 
with resource utilization statistics. The traffic data comes from Interface Reporting, while the 
resource data comes from Device Resource. The term summary in the title refers to the fact 
that traffic volume for each interface on the device is being rolled up to the device level.

Use the table at the top of the report to spot high busy hours. The graphs below provide hourly 
and daily views of resource utilization and traffic volume. Use the graphs to:

• View hourly data for yesterday (showing the busy hour in context)

• Compare yesterday’s performance to performance throughout the preceding week

• Track average utilization, maximum utilization, and the percentage of exceptions

Is there a correlation between traffic volume and resource utilization? Usually not. If traffic 
volume is up, resource utilization could be up or it could be down. If traffic volume is down, 
resource utilization should be down also. If traffic volume is low, but resource utilization is 
high, this could indicate that a resource is not functioning properly.

Report 2: Device Single View Top Ten Summary [see sample below]

Like the preceding report, this report combines traffic volume statistics with resource 
utilization statistics. This report looks at yesterday’s performance and estimates for future 
performance. Use it to see which devices ranked worst yesterday and which devices are likely 
to see poor performance in the near future.

The tables on the left provide statistics for average utilization and yesterday’s busy hour. 
Table entries sort by average utilization, highest to lowest. The tables on the right provide 
statistics for baseline busy hour, F30, F60, and F90. Table entries sort by F90 value, highest 
to lowest. Most of the time you will not see the same device listed in both tables, left and right. 
If the same device appears in both tables, yesterday’s performance is probably not an isolated 
incident; it is instead part of a longer-term trend that may require your attention.
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Report 3: Executive Summary [see sample below]

This is a location-oriented, single view report. After you select a location, the table at the top 
profiles each customer in terms of yesterday’s percentage of exceptions. Use this report to get 
a sense of how customers compare to each other at each location. The graphs below the table 
allow you to look at hourly details on a customer-by-customer basis, and you can also compare 
yesterday’s performance to performance during the preceding week.

Report 4: Executive Summary Aggregate Availability and Traffic [see sample below]

This report provides aggregated information for the day, as opposed to aggregated information 
for a particular location or customer. The top table gives you daily figures for availability and 
traffic, and covers the preceding week. The bottom chart provides the same information for 
each of the previous 30 days. Use the top table to find out if availability and traffic volume are 
stable, improving, or worsening. Use the bottom table to see whether this week’s figures 
deviate from or align with historic performance.

Report 5: Executive Summary Top Ten Report [see sample below]

This report highlights exceptions on a customer-by-customer basis and ranks the locations 
that belong to the selected customer. Use this report to find out:

• Which customers are seeing the most exceptions

• Which locations had the worst performance yesterday

• Which locations are expected to have poor performance in the future

The selection table at the top sorts customers by total exceptions, highest to lowest. The tables 
along the left sort locations by yesterday’s average resource utilization, worst to best, while 
the tables along the right sort locations by F90 value, worst to best.

Most of the time you will not see the same location listed in both tables, left and right. If the 
same location appears in both tables, yesterday’s performance is probably not an isolated 
incident; it is instead part of a longer-term trend that may require your attention.
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Glossary
availability

The percentage of time the device is operational. Identifies device outages indicated by the 
sysuptime variable but does not account for periods of time the device could not be reached by 
OVPI.

average utilization

In an hourly graph, this is the average of four samples taken over a one-hour period. In a daily 
graph, this is the average of 96 samples taken over a 24-hour period.

baseline

The average of 91 busy hour readings over the baseline period. 

baseline period

The previous 91 days. Forecasts for F30, F60, and F90 values are based on performance 
during the baseline period.

busy hour

Highest hourly average for the day, not a peak nor momentary event (actual utilization could 
be higher or lower during the course of that hour). The highest average hour among 24 hourly 
averages.

Common Property Tables

Locations and customer names appear in reports if you have imported this information using 
the Common Property Tables package. Refer to the Common Property Tables user guide for 
more information about importing this information. If you do not import customer names, 
data for all customers rolls up under the “All Customers” name. If you do not import locations, 
data for all locations rolls up under the “All Locations” name.

daily

A view of performance that compares average utilization to busy hour utilization. The number 
of days that you can see in this view depends on the number of days that data has been 
collected. The maximum number of days is the baseline period (91 days). Daily views also 
include performance data from yesterday, the same data visible in the hourly view, rolled up 
as one average and one busy hour.

device

A router or switch, not a server. In selection tables, devices are listed by IP addresses or 
hostname.

exception

An event that occurs when utilization exceeds the allowable threshold.
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F30 / F60 / F90

The level where utilization or volume is expected to be 30, 60, or 90 days from now. Values are 
calculated by applying linear regression to busy hour levels over the baseline period.

hourly

An average derived from four collections taken once every 15 minutes. Or, a graph showing 
yesterday’s hourly increases and decreases.

summary

An aggregation of multiple samples. In an hourly graph, an average based on multiple 
samples collected during one hour. In a daily graph, an average based on multiple samples 
collected over the course of each day. In customer and location reports, an aggregation of 
multiple averages for multiple devices across the same hour, day, or month.

threshold

The point at which the acceptable percentage of traffic errors/failures becomes abnormal and 
may impact response time. The default threshold values for buffer, CPU, and memory 
utilization is 85%.

utilization

The value of the metric in used divided by the total available resources for that metric, 
multiplied by 100 (measured as a percentage).
44



Index
A
add map

LIR, 25

applying constraints to a report, 11

availability, 43

average utilization, 43

B
baseline, 43

buffer utilization threshold, 44

busy hour utilization, 43

C
central server

configure, 25

Common Property Tables, 43
install prerequisites, 18
upgrade, 15

configure
distributed system, 23

constraints
applying, 11

copy policy
verify, 26

CPU utilization threshold, 44

D
daily, 43

database role
set, 25

device, 43

device reports, 10

Device Resource
upgrade, 15, 19

DeviceResourceReporting_Hourl.pro
modify on satellite server, 28

DeviceResourceReporting_Hourly.pro
modify on central server, 27

device single view summary report, 32

device single view top ten report, 34

distributed system
add LIR mapping, 25
configure central server, 25
configure satellite server, 27
enable LIR, 25
install, 18
modify DeviceResourceReporting_Hourly.pro on 

central server, 27
modify DeviceResourceReporting_Hourly.pro on 

satellite server, 28
modify IR_DevPort_DMF_Process.pro on 

satellite server, 28
modify IR_DevPort_Hourly_Process.pro on 

satellite server, 28
modify trendtimer.sched on central server, 27
modify trendtimer.sched on satellite server, 27
register satellite server, 25
satellite server packages, 24
setting up, 23
synchronize system clocks, 29
upgrade, 14
verify copy policy, 26

duplicate polling, 24

E
enable

LIR, 25

exception, 43

executive summary availability & traffic report, 38

executive summary report, 36

executive summary top ten report, 39

extract
package, 14, 18, 19

F
F30, 44

F60, 44

F90, 44
  45



G
guidelines

install, 17
upgrade, 13

H
hourly, 44

I
install

distributed system, 18
guidelines, 17
new, 17, 18
package, 19
prerequisites, 17
requirements, 17
upgrade, 13, 14
UPGRADE_ES_to_11, 15

interface, 44

Interface Reporting
upgrade, 15, 19

IR_DevPort_DMF_Process.pro
modify on satellite server, 28

IR_DevPort_Hourly_Process.pro
modify on satellite server, 28

L
LIR

add mapping, 25
enable, 25

list of reports, 10

location reports, 10

M
memory utilization threshold, 44

metrics, 10

modify
DeviceResourceReporting_Hourl.pro on satellite 

server, 28
DeviceResourceReporting_Hourly.pro on central 

server, 27
IR_DevPort_DMF_Process.pro on satellite 

server, 28
IR_DevPort_Hourly_Process.pro on satellite 

server, 28
trendtimer.sched on central server, 27
trendtimer.sched on satellite server, 27

N
new install, 17

O
OVPI Timer

start, 15, 20
stop, 14, 18

P
package

extract, 14, 18, 19
install, 19
remove, 16, 20
uninstall, 16, 20

polling
duplicate, 24
split, 24

prerequisites
install, 17
upgrade, 13

R
register

satellite server, 25

remove
package, 16, 20

report
constraints, 11

reports
device, 10
device single view summary, 32
device single view top ten, 34
executive summary, 36
executive summary availability & traffic, 38
executive summary top ten, 39
list of, 10
location, 10

requirements
install, 17
upgrade, 13

RIRRouterSystem table, 28

S
satellite server

configure, 27
distributed system packages, 24
register, 25

set
database role, 25
46



setting up
distributed system, 23

SHIRDevPorts table, 28

split polling, 24

start
OVPI Timer, 15, 20
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